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Welcome to mocha, tracking and rotoscoping tools that make your tracking 
and rotoscoping work much easier. Our tools are based on our proprietary 
Planar Tracking technology, an awesome approach to 2D tracking which will 
help you to generate accurate corner-pins and track and transform your roto 
splines in a powerful way.   
 
Please note: This manual covers all products in the mocha family.  Export and 
interface features may differ between mocha v2, mocha for After Effects and 
mocha for Final Cut. 
 
For installation instructions, please refer to the release notes at: 
 
http://www.imagineersystems.com/products/release_notes/ 
 
For video tutorials, please visit: 
 
http://www.imagineersystems.com/products/ 
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Introduction 
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IMPORTANT CONCEPT 

The Planar Tracker provides 2D tracking data similar to 
that obtained from point trackers, but it tracks planes 
instead of points. It can be used to determine position, 
scale, rotation, shear and perspective motions and the 
result can be output as traditional corner-pin data. 

 

There Are No Point Trackers 
In our tools, splines are used for both tracking and rotoscoping. You will not 
find standard 1-point or multi-point tracking tools in our software. 
 
Once you have learned to harness the power of the Planar Tracker, you will be 
able to get spot-on tracks faster and create shapes with less manual adjustments 
than you probably thought possible. 
 
Traditional tracking tools require that you locate “points” that remain 
consistent throughout the entire shot in order to track movement. This is itself a 
difficult task, especially when tracking a shot that was not originally designed to 
be tracked. If you wish to also track rotation, perspective and shear you need 
even more clear and consistent points to track. 
 
Traditional roto methodology would have you outline a shape with the 
minimum number of points necessary then either manually move the control 
points or track the shape with a point tracker to “get it close”. Even when using 
multi-point trackers to impart rotation and scale to the roto spline, the results 
are often unusable if there is any perspective change during the shot. 
 
Imagineer’s Planar Tracker doesn’t employ point trackers, but tracks an object’s 
translation, rotation and scaling data based on the movement of a user defined 
plane.  
 
A plane is any flat surface having only two dimensions, such as a table top, a 
wall, or a television screen. Look around you - planes are everywhere. With the 
Planar Tracker, planes will quickly become your friends. Planes provide much 
more detail to the computer about an object’s translation, rotation and scaling 
than is possible with point based tracking tools. Even as an object leaves and 
enters a frame, there is usually enough information for the Planar Tracker to 
maintain a rock-solid track of the object, something impossible with traditional 
tracking techniques. 
 
When you begin working in our tools, you will need to look for planes in the 
clip. More specifically, you will need to look for planes that coincide with 
movements you want to track. If someone is waving goodbye, you can break 
their arm into two planes - the upper and lower limbs. Although not all of the 
points on the arm sections actually lie on the same two-dimensional surface, the 
apparent parallax will be minimal. 
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The Art of Tracking 
Tracking and rotoscoping are part of almost any visual effects project. For 2D 
tracking, point trackers are most commonly used, but to get good point tracks 
requires a mix of experience and luck. You would often “prime” a clip for 
optimum tracking using color correctors and other image manipulations. If the 
point being tracked exits frame, you get into offset tracking, which presents its 
own set of challenges. If it all fails, you are into hand tracking, which is time 
consuming and very hard to get accurate. 
 
Mocha is a 2D tracker that requires less experience and luck to be successful 
with, does not require the image to be primed and is less likely to require a lot 
of tricks or hand tracking on difficult shots.   
 

The Art of Rotoscoping 
Most often a good matte requires a combination of both keying and 
rotoscoping techniques. Our products are not keying tools, they are dedicated 
rotoscoping tools. Good rotoscoping artists often think like animators, reverse 
engineering the movements, the easing in and outs, the holds and overshoots of 
objects, and set their keyframes accordingly.  
 
In general, the fewer the keyframes, the better your mattes will look. Too many 
keyframes will cause the edges to “chatter” and move unnaturally. Too few 
keyframes will cause the shapes to drift and lose definition. Finding the right 
number and placement of keyframes often comes with experience but there are 
a few things to keep in mind when rotoscoping: 
 

TRADITIONAL ROTO TIPS 

1) There is no such thing as a perfect matte. 
Rotoscoping is an art form that takes into account the 
background image, the movement of the object, and 
the new elements to be composited in the background. 

2) Try to start your shape at its most complex point in 
time, where it will need the most control points. 

3) Break a complex shape into multiple simple shapes. If 
you are rotoscoping a humanoid form and an arm 
becomes visible, consider rotoscoping the arm as its 
own element, rather than adding extra points on the 
body that will serve no purpose when the arm is 
obscured. 

4) Imagine you are the animator who created the shot. 
What would your dope sheet look like? No matter the 
medium, whether CG, live action or otherwise, most 
movements are rarely linear. They normally move in 
arcs; they normally accelerate in and out of stopped 
positions. Try and understand the mechanics behind 
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how things are moving in your shot. This will help you 
to minimize keyframes. 

5) Watch and study the shot before you start working. 
Where are the changes in directions? These will 
normally have keyframes. Where are the starts and 
stops? Are there camera moves that can be stabilized to 
make your work easier? 

6) Don’t be afraid to trash your work and start over. 
Beginning roto artists often make the mistake of trying 
to fix a flawed approach by adding more and more 
keyframes. Experienced roto artists learn to quickly 
identify an inferior approach and are unashamed to 
trash their work and start over, often many, many 
times. It is very difficult to get a good matte without a 
conscious effort to keep the keyframes to a minimum. 
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To quickly get familiar with mocha before you dive into the rest of the manual, 
here is a breakdown of the interface and its controls. 
 
Note: Interface Overview uses mocha v2 Interface.  Mocha for After Effects and 
mocha for Final Cut may differ in presentation, but their tools perform the same 
function 

The Main Toolbar 

 
 
At the very top of the interface you have the tools that form the brunt of your 
time inside mocha. 
 

 
New Project: Starts a project wizard for a new clip 
 

 
Open Project: Open a previously saved project 
 

 
Save Project: Save the project 
 

 
Undo: Undo tasks 
 

 
Redo: Redo tasks revoked by Undo 
 

 
Select: Selection tool for splines and points 
 

 
Select Both: Selects both the Inner spline points and the edge points 
 

 
Select Inner: Only selects the inner spline points 

 
Select Edge: Only selects the outer edge points 
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Select Auto: Automatically selects between Inner and Edge points 
 

 
Add Point: Tool to add points to the spline 
 

 
Pan: Used to pan the footage in the Viewer 
 

 
Zoom: Used to zoom into footage in the viewer 
 

 
Create  X-Spline Layer: Draw a new X-Spline layer 
 

 
Add X-Spline to Layer: Draw an X-spline that is added to the current 
spline layer. 

 
Create B-Spline Layer: Draw a new B-Spline layer 
 

 
Add B-Spline to Layer: Draw a B-spline that is added to the current 
spline layer. 

 
Attach Layer:  Used to select a point and drag-lock it to another layer’s 
spline point.  Useful for lining up individual splines. 

 
Lock Tangents: Lock the tangents of the point in a spline 
 

 
Rotate: Rotate selection around the axis of the point you click in the 
viewer 

 
Scale: Scale Selection 
 

 
Move: Move selection 

 
 

The Viewer Controls 

 
 
These controls cover what can been seen or hidden while working in the mocha 
viewer. 
 

 
Clip to Show: Choose which clip to view from this 
dropdown 
 

 
Proxy Scale: Adjust the resolution of the footage for 
performance 
 

 
Show RGB Channels: Turns on the RGB color view of 
the footage 
 

 
Show Aplha Channels: Turns on the Alpha view of the 
footage 
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Show Layer Mattes: Toggle on or off to show the 
mattes.  Select from the dropdown to choose the type of 
matte 
 
 
 
 

 
Colorize Layer Mattes: Fills matte with colour. 
Decreasing the value lessens the opacity 
 

 
Overlays: Toggles all viewer overlays, including splines, 
tangents, surface and grid 
 

 

Show Layer Outlines: Toggles all spline overlays, 
including splines, points and tangents 
 
 
 

 

Show Spline Tangents: Toggles spline tangents view. 
Select from the dropdown to choose the type of view 
 
 
 
 

 
Show Planar Surface: Toggles the planar surface view 
 

 
Show Planar Grid: Toggles a grid relative to the planar 
surface view.  You can adjust the number of grid lines 
under Viewer Preferences (See below) 
 

 
Show Zoom Window: Toggles the Zoom window  
 

 
Stabilize: Turns on stabilize view.  This centers the 
footage around your tracked surface. 
 

 
Trace: Turns on the traced path of the tracked surface.  
You can adjust the amount of frames to trace under 
Viewer Preferences (See below) 
 

 
Preview: Toggles view of inserted clips as well as 
previews of stabilization in the Stabilize module 
 

 
Enable Brightness Scaling: Toggles brightness 
adjustment to work with low-contrast footage. 
 

 
Viewer Preferences: Adjustments dialog for 
parameters such as grid lines and trace frames 
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The Timeline Controls 

 
 
The timeline controls cover frame range, playback, tracking controls and key-
framing. 
 

 
Project In Point: Frame where timeline playback 
starts 
 

 Set In Point: Set the in point for the timeline 
 

 Reset In Point: Set the in point back to the start 
of the clip 
 

 
Current Frame: The frame the playhead is 
currently on.  Enter a new value to jump to that 
frame. 
 

 Reset Out Point: Set the out point back to the 
end of the clip 
 

 Set Out Point: Set the out point for the timeline 
 

 
Project Out Point: Frame where timeline 
playback ends 
 

 Zoom Timeline to In/Out points: Expands the 
timeline between the in and out points to the 
edges of the viewer 
 

 Zoom Timeline to full frame range: Resets the 
timeline scale to the full range of frames 
 

 
Play Controls: Controls for playing back and 
forth and moving one frame at a time 
 

 Change Playback Mode: Toggles tri-state button 
between Play once, Loop and Bounce playback 
modes.  
 

 
Tracking Controls: Controls for tracking back 
and forth and tracking one frame at a time. 
 

 Go to Previous Keyframe: Jump to the previous 
keyframe set in the timeline for that layer 
 

 Go to Next  Keyframe: Jump to the next 
keyframe set in the timeline for that layer 
 

 Add New Keyframe: Add a new keyframe at the 
current position for the selected layer 
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 Delete New Keyframe: Deletes the keyframe at 
the current position for the selected layer 
 

 Delete All Keyframes: Deletes all keyframes on 
the timeline for the selected layer 
 

 Autokey:  Toggles automatic key insertion when 
moving points or adjusting parameters 
 

 Überkey: Toggles the Überkey, which modifies all 
keys in the layer relative to the key you are now 
on.   

 
 

Layer Controls 
 

The top left hand panel contains the tools to 
manage layers. 

 
 
 
 
 

 

Layer Icons: Click the eye to toggle layer 
visibility, Click the cog to toggle tracking for 
that layer and click the lock to toggle locking. 
 

 Duplicate Layer: Duplicates the current layer 
 

 Delete Layer:  Delete currently selected layer 
on all frames 
 

 Delete Spline in Layer: Deletes the currently 
select spline in the layer.  If there is only one 
spline, it also deletes the layer 
 

 Lock All Layers: Toggles locking of all layers 
in the layer panel 
 

 Lock Unselected:  Toggles locking of all 
unselected layers 
 

 Align Surface: Expands the layer surface to 
fit the dimensions of the footage at the 
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current frame.  All tracked data is made 
relative to this new alignment. 

  
  
  

Layer Properties 
 
The section under the Layer Controls panel 
contains the properties for each layer. 

 
 
 
 
 

 

Layer In/Out frames:  Settings to change 
where the layer turns on and off in the clip 
 
 

 

Blend mode: Dropdown to add or subtract 
your spline to the current layer.  Invert flips 
this 
 

 

Insert Clip: Insert a demo clip to preview 
your track.  You can use one of the defaults or 
import your own.  For preview purposes only 
 

 

Matte Clip: Replaces the current layer splines 
with a matte clip.  

 

Link to Track: Which layer’s track to link your 
layer splines to.  Can also be set to None. 

 

Link to adjusted track: Optional checkbox 
to link the layer splines to the adjusted track 
of the selection in “Link to Track” 
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Starting a New Project 
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Overview 

Be sure and grab the tutorial files for the examples in 
this guide from: 

http://www.imagineersystems.com/downloads/clips/moc
ha_quickstart.zip 

The basic tracking workflow in our tools is: 
 

1. Import your footage 
2. Draw a loose spline around the shape you want to track. Track the spline 
3. Set the ‘Surface’, or corner pin where you want the inserted image 
4. Adjust track if necessary  
5. Export the completed track 

 
The basic rotoscoping workflow is very similar: 
 

1. Import your footage 
2. Draw a loose spline around the shape you want to track. Track the spline 
3. Adjust track if necessary 
4. Add new shapes for rotoscoping that are linked to your track  
5. Export the rendered mattes or the shape data 

 

The Workspace   

Take a few minutes to familiarize yourself with the workspace: 

 
 
In the center is a canvas, where most of the work is done. At the top, we have a 
toolbar, where commonly used tools are accessed. A number of dockable panels 
are on the left side. At the bottom is a panel which contains the parameter 
controls and a curve editor. 
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Many of the controls will probably be obvious to you, such as Edge Properties, 
but others like the Layer Controls should be looked at more closely. 

Creating a New Project 
When you start the application you are presented with an empty workspace. No 
footage is loaded and most of the controls are consequently disabled. To begin 
working, you must open an existing project or start a new project.  
 
Choose File -> New Project… or select the New Project 
icon on the toolbar. A step-by-step wizard will guide 
you through the process of getting your project set up 
properly. 

 

Import your footage 

Select the clip to import by clicking on the 
Choose… button to the right of the top 
line. This will bring up a file browser, 
where you can select almost any industry 
standard file formats. Image sequences 
will show up as individual frames. You 
can select any one of the frames and the 
application will automatically sequence 
the frames as a clip when importing.  
 
 
 
 
 
 
 
 
 

Check your Settings 

 
Name: A project name will automatically 
be generated based on the filename of 
the imported footage, but you can 
change it by editing the Name field. 
 
Location: Your project file and cache 
files will output to a directory called 
“Results” by default.  This is created in 
the same folder your clip is imported 
from. You can change this using the 
Change… button or using the dropdown 
box to set a different relative or absolute 
path. 
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Frame Range: The range of frames to import. 
 
Frame Rate: Normally this is automatically detected, but you have options to 
adjust if necessary. 
 
Separate Fields: If you are using interlaced footage, set your field separation 
here to Upper or Lower. 
 
Remove Pulldown: If your footage has pulldown, set it here. 
 
 
 

Advanced options 

Clicking the Advanced tab will provide 
you with important settings such as 
frame offset and color space.  
 
Frame offset: Normally this is set to 0 
or 1.  You also have the option to view 
as Timecode or Frame numbers. If your 
clip has an embedded timecode offset, 
you may see this appear here as a 
large number. 
 
Caching: If you wish the clip to be 
cached into memory, check the Cache 
clip checkbox here. Caching is 
recommended if you are working a 
computer that has fast local storage, 
but your shot is stored in a slow 
network location. If your shot is 
already stored on fast storage, you don’t need to cache. 
 
Colour space: Set to Linear, Log and Panalog. 
 
Conversion: Set to None, Float or 8-Bit 
 
Offset: If working with log color space, set any offset here. 
 
Soft clip: If working with log color space, set soft clip value here.  Default is 
zero making falloff linear, rather than curved. 
 
Log reference white: If working with log color space, set white reference 
value here. 
 
Log reference black: If working with log color space, set black reference value 
here. 
 
Gamma: If working with log color space, you can adjust Gamma here. 
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Setting the In and Out Points 
Once you have created a new project you can set the In and Out points if you 
know you will only be working on an isolated section of the shot. Hover over a 
button and a tooltip will quickly appear describing the button’s behavior. Note 
that the In and Out points affect the range of the Überkey button (see page 50 
for more on Überkey). 
 

 
 
You can zoom the timeline to only show you the part between you In and Out 
points by clicking the Zoom Timeline button. 

 

IMPORTANT CONCEPT 

Interlacing and frame rate are especially important to 
get correct if you intend to export tracking or shape 
data to another application. 

If footage settings do not match between your 
mocha/motor project and your compositing/editing 
application, the track or shape data can be offset 
strangely when imported. 
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Tracking Basics 
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For the following example you need the iPAQ tutorial 
files available from: 

http://www.imagineersystems.com/downloads/clips/moc
ha_quickstart.zip 

You can also watch a video tutorial covering some of 
the topics discussed here: 

http://www.imagineersystems.com/products/monet/moc
ha_tutorial.mp4 

Overview 
Imagineer’s Planar Tracker technology can provide the same 2D tracking output 
as a 1-, 2-, 3- or 4-point track, but does so by tracking planes rather than points. 
 
The key to getting the most out of the Planar Tracker is to learn to find planes 
of movement in your shot which coincide with the object that you want to track 
or roto. Sometimes it will be obvious - other times you may have to break your 
object into different planes of movement. For instance if you were tracking a 
tabletop, you would want to draw the spline to avoid the flower arrangement 
in the center of the table — it is not on the same plane and will make your track 
less accurate. 
 
To select a plane you simply draw a spline around it. You can be fairly loose with 
your spline — the Planar Tracker is intelligent enough to discard the pixel 
movement that doesn’t conform to the movement of the majority of the pixels 
within the shape. 
 
Our tool feature two spline types, X splines and Bezier splines. 
 

  

 

  
An X spline  A Bezier spline 

 
In general X splines work better for tracking, especially with perspective motion. 
Nevertheless the Bezier Spline is versatile and is the industry spline standard.  
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Selecting What to Track 
Most tracking applications use small rectangular boxes for selecting what to 
track. Our tools use splines. 
 
For example if you are tracking the position of mobile phone screen, you would 
normally have to look for a point of high contrast that was relatively stable, 
with no significant brightness changes over time to get a good track. You may 
have to reposition the tracker to another more desirable point half-way through 
the track if your original point moves out of frame. This makes point tracking 
very complicated.  
 
With the Planar Tracker you simply draw a spline around the screen as shown 
below. 
 

 
 
 

Try this out on the iPAQ demo clip:  Use the shape tool  to create a shape 
around the outside edge of the iPAQ. You will notice that the shape is not tight 
on the edge but actually has a little space to allow for the high contrast edges to 
show through, as these provide good tracking data. 
 
Start creating your shape by clicking onto the screen. After the third point, the 
shape will auto-close, but you can continue to add points. After you have added 
all the points you need, right-click to close. 
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Dealing With Obstructions or Reflective Surfaces 

In some cases there are parts of an image that can influence the effectiveness of 
the Planar Tracker. To handle this, you can create an exclusion zone in the area 
you are tracking.  
 
For instance, in the iPAQ example we are using, there are frames where there 
are strong reflections on the screen. These reflections can make the track jump. 
So what we need to do is isolate that area and tell the tracker to ignore it. 
Here’s how this is done: 
 

First select the initial layer you created. 
 
 
 
 
 
 
 

Second, select the add shape tool to add an additional shape to the current 
layer, which selects the area you want the tracker to ignore. 
 

 
Draw this second shape inside the 
screen. Note that both splines have the 
same color, which is an indication that 
they belong to the same layer. Also you 
will notice in the Layer Controls panel 
that you only have a single layer. 
 
 
 
 
 

 
Lastly, using the handles at each point, pull 
them out to create a straight cornered 
shape. 
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By turning on the Mattes button under 
View Controls you can see the area that 
will be tracked. 
 

 
 
 
 
 
 

Before You Track 
Various tracking parameters can be accessed by selecting the Track tab. On the 
left hand side of the Track tab, you will see two sections: Motion and Search 
Area. 
   
Motion allows you to define the type of motion the tracker should be 
calculating and whether it should expect large motions (specified in the Search 
Area) or only small motions (up to about 3 pixels shift per frame), which is faster 
and great for 
tracking small 
jitters to be 
stabilized. 
 
The settings under 
Search Area allow 
you to control how 
large a motion the 
tracker should 
expect, similar to 
the way you would 
increase the size of the rectangle for a point tracker to handle faster motion. 
 
If the object in your shot is moving significantly and you are working on a large 
2k–4k image, you may wish to manually enter some large pixel values. 

1-, 2-, 3- and 4-Point Style Tracking  

If you would like to track just x,y position information, like a traditional point 
tracker, then select only Translation in the Motion section. 
 
If you’d also like to track the Scale and Rotation, simply check the Motion mode 
to include Rotation + Scale. 
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 2-point tracking mode 
 
Keep in mind, because this is a Planar Tracker, you do not have to track two 
separate splines. Unless they are on the same plane of movement, this will 
actually make for a poor track. Trust the planar tracker to derive the Rotation 
and Scale based on pixel movement within the spline. 
 
4-point or corner pin tracking is where the Planar Tracker really begins to shine. 
You can achieve more accurate tracks faster than you would think possible. 
 

 4-point / corner pin tracking mode 
 

Perspective tracking works best on larger objects with 
severe perspective 

Tracking the Spline 
Before we move on to performing the actual track, we first 
need to adjust a couple of settings depending on the 
movement in the clip. 
 
In this example, keep the default motion settings Translation, 
Rotation + Scale and Shear, which is the equivalent of a 3-
point track. 
 

 
Track the plane selected by pressing the Track Forwards button on the right-
hand side of the transport controls section. 
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Stop the track and adjust the shape if it doesn’t seem to be tracking properly. 
You may keyframe the spline shape so that it tracks only the planar region of a 
shape by adjusting the shape and hitting Add Key in the keyframe controls 
menu. Keep in mind that no initial keyframe is set until you first hit Add Key or 
move a point with Auto-Key turned on. 

Checking Your Track 
The spline should be tracked in addition to the clip being cached to RAM. You 
can play it back and get an idea as to how the track went. Feel free to change 
the playback mode in the transport controls to loop or ping-pong your track. 
 
Another trick you can do to check your track is hit the Stabilize button in the 
View Controls. 
 

 
 
Turning on Stabilize will lock the tracked item in place, moving the image to 
compensate.  
In the track module, stabilize view is a preview mode to check your track.  Actual 
stabilization output is handled by the Stabilize Module, explained in the 
Stabilize Overview chapter. 
 
You can check the accuracy of your planar track by turning on the Surface and 
Grid overlay in the View Control panel. Drag the corners of the Surface overlay 
(the dark blue rectangle) to match the perspective of your tracked plane. If you 
play the clip, you should see the surface or grid line up perfectly with the plane 
you tracked. 
 

IMPORTANT CONCEPT 

The Surface and Grid have no keyframes; they are 
simply guides that let you check the accuracy of your 
track. Note that the position of the Surface WILL affect 
the exported tracking data, so you MUST position the 
corners of the Surface before exporting tracking data. 

 
 

Next click on the Surface button  under View Controls. 
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When you turn on the surface 
you will see the blue box that 
represents the 4 points of the 
corner-pin.  Right now you will 
see that it is not lined up with 
the screen. 
 
 
 
 
 
 
 
 
 
 
 

By selecting each corner one at a 
time you can adjust the surface 
area to cover the area of the 
screen. 
 
 
 
 
 
 
 
 
 
 

 
 
The Grid overlay should line up with the 
plane you’re tracking and move with it as 
you cycle through the clip. You can change 
the density of the grid by adjusting the X 
and Y grid values in View | Viewer 
Preferences: 
 

 
 
The grid overlay can give you a quick 
representation of the accuracy of the track. 
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The Trace feature allows you to 
see the position of the planar 
corners over time. Skip allows 
you to work with only every nth 
frame, useful on particularly 
long roto shots where the 
movement is predictable. 
 
 
 

 

 
 

 

IMPORTANT CONCEPT 

When you track a layer, the mattes of any active layers 
above the layer itself are subtracted from the matte of 
the layer and hence influence the area being tracked. 
To keep your tracking predictable, it is recommended 
that you keep your tracking layers on the top of the 
stack unless you specifically wish to use other layers to 
subtract from the tracking area of layers beneath it. 

 
To monitor what the tracker “sees” as a tracking area, select the Track Matte 
button in the view control. 

 
 

Importing Mattes 
There may be instances where you have already created mattes for one or more 
objects in the shot, for example using a keyer or another roto tool that would 
help you isolate areas to track. You can import such mattes by creating a new 
layer and then using the Matte Clip setting under Layer Properties to assign it to 
the layer. 
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Adjusting the Track 
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Overview 
Manual refinements can be made by using the AdjustTrack tool. AdjustTrack is 
primarily used for eradicating drift. It cannot be used to remove jitter. The 
concept is fairly simple; it utilizes the four-corner surface area to generate 
keyframable data which will compensate for tracking drift. To achieve an 
adjusted track you would ideally line up the surface area where you want to 
place your insert. In situations where you don’t require an insertion you should 
place the corners of the surface area in distinctive locations, as you will need to 
refer to these locations when you add keyframes to correct the drift. 

Starting the Track Adjustment  
When you have the Surface at a 
satisfactory location and are ready to 
refine the track, flip over into the 
AdjustTrack module by hitting the 
AdjustTrack tab. 
 
 
 
 
 

Reference Points 
Once you select the AdjustTrack tab, a 
key frame with four reference points is 
created. Note: You should be on your 
desired master frame before selecting 
the AdjustTrack tab. The reference points 
can then be positioned on distinctive 
features, such that any drift in the track 
can be easily seen and corrected. 
 
As you play though the sequence you will 
be able to manually adjust the position 
of each point as drift occurs. 
 
If your track is spot on, these reference points should line up properly 
throughout the shot. If you see a Reference Point drifting, that will indicate the 
track is drifting. Find the frame where the drift is worst and move the Reference 
Point back to the position it had in the Master Frame and the track will 
automatically be adjusted based on your correction — it's as easy as that! 

Reference Point Quality 
When you perform an adjust track and you begin to move 
a newly created reference point, you will notice the 
dashed lines which connect all of the reference points. 
These lines change in color to represent the quality of 
positioning of any given reference point. For best results 
keep reference points away from one another. 
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When adjusting the track try to always get at least yellow but shoot for green 
for a more solid adjust track. 

 
The red lines indicate that this reference 
point position is a poor choice. 
 
 
 
 
 
 
 
 
 
 

The green lines indicate that this reference 
point position is a good choice. 

 
 
 
 
 
 
 
 

AdjustTrack with More than Four Reference Points 
Often there are times where your reference points are either obscured or exit 
frame. In AdjustTrack you have the ability to create multiple reference points 
per surface corner that can be positioned in alternate locations to handle these 
situations. Simply click the New Ref button to create a new reference point for 
the selected corner. 
 

You cannot keyframe the Surface — only the Reference 
Points.  The original track and any refinements you 
make in AdjustTrack cause the Surface to move 
however. 

Working Backwards  
Every so often a shot will come along that is easier to track backwards than 
forwards. This is fairly simple when running the tracker backwards, but 
introduces some rather obtuse concepts when keyframing is involved. This is 
why there are two “New Ref” buttons provided. If you are working backwards 
and wish to set a new reference point, you will probably want to use the “<-
New Ref” button instead of the forward-thinking “New Ref ->” button. 

 
Because keyframing “thinks” 
forward, hitting “<-New Ref” will 
not create new Master Reference 
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points on the current frame, but will go backwards in time, looking for any 
existing keyframes and set new Master Reference points on the frame directly 
after. For example, if you decide to create a new backwards reference point at 
frame 20, a new master reference will be created at frame 21. 
 
Some people may be more comfortable doing this manually by moving the 
playhead themselves and using the traditional “New Ref ->” button. Others who 
do a lot of tracking and find themselves working backwards often may find the 
backwards-thinking New Ref button helpful. 

About Master Reference Points (the red X) 
Every Reference Point has one frame in which its initial placement is determined 
without causing any adjustment to the track. This is called the Master Reference 
Point; if you step forward or backward in time you will notice the red X change 
to a red dot. 
 
The red X indicates that this particular frame is the 
starting point for calculating adjustments. Moving a 
Master Reference Point will NOT change the tracking 
data. 
 
Go ahead and experiment - move the Reference Point 
when it is a red X (a Master Reference Point). You will 
notice the Surface isn’t adjusted at all. Step forward a 
frame and move the same point - this time the surface 
will move because you are now adjusting the track. 

Changing the Master Frame for a Reference Point 
 
By default, the frame in which you create a Reference 
Point is its Master Reference frame. This Master 
Reference can occur on a different frame for each 
reference point. You can change the Master Reference 
frame by selecting a Reference Point, going to the 
appropriate frame and hitting the “Set Master” button. 
 
  
 

 
You may set a new Master Reference Frame for all active 
points by hitting the Set Master All button. 
 

Selecting Different Reference Points 
One method for selecting different reference 
points is to hit the “Next” button. 
 
The next button simply cycles through the 
active reference points for that frame. More 
fine-grained control of reference points can be 
obtained through the Nudge control panel, 
described below. 
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Deleting Reference Points 
Deleting Reference Points is done by selecting the point you wish to remove and 
hitting the delete key. If there are multiple Reference points on a particular 
corner, the preceding Reference Point will be extended through your time line 
until a new Reference point is encountered. 

Nudging Reference Points 
The Nudge section allows you to move Reference points in 0.1 pixel increments, 
much more fine grained than would be possible by dragging the points 
manually. You can easily select any active Reference 
Point by selecting one of the corner buttons in the 
Nudge section. 
 
If you hit the Auto button, a tracker will attempt to 
line up the selected Reference Point based on its 
position in the Master Reference frame. The Search 
Region Size and Maximum Motion parameters can 
be set in pixels in the Auto Nudge section. 
 
You can quickly select any corner by using the Corner selector buttons in the 
Nudge control panel. In the image below, the user is selecting the upper right 
corner in preparation for nudging operations. 

View Options 
The AdjustTrack tab has a View section for cleaning up your 
AdjustTrack workspace. Deselecting the Inactive Traces 
button will cause the display to hide the traces of the 
inactive Reference Points. This is helpful if you have a corner 
with numerous Reference Points offsetting it.  
 
Deselecting the Unselected Traces button will hide any 
Reference Point that is not selected.  
 
Finally, deselecting the Search Area button will hide the 
Search Region Size (in Yellow) and the Maximum Motion 
search area (in Pink). 

AdjustTrack Keyframing 
The AdjustTrack tab has a setting that determines 
whether keyframes are per corner point or per 
surface. 
 
Normally, you would want to keep your corner 
adjustments discrete, so that adjusting one would 
not automatically set a keyframe on another 
corner. In this case, you would want to keyframe by 
points. There are some special cases where you 
want to create a keyframe on every active 
Reference Point when any one of them is 
manipulated. For this case, choose the Corner Pin 
keyframing method. 
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Stabilization Overview 
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Overview 
The stabilize feature in Mocha V2 uses the data you have tracked to lock down a 
moving shot.  You can think of it as the inverse of what tracking does: It moves 
the footage around an area rather than an area around the footage. 
Stabilization is useful for: 
� Removing camera jitter and bumps 
� Locking off a shot so it is easier to work with, before restoring the motion 

back into the final composition 
 

The Interface 
 
Stabilization is a fairly straightforward operation.  Once you have selected the 
tracked layer you wish to work with you have options to restrict the stabilization 
to key details. 
 

 
 
Input Tab: Select the clip that you wish to use to stabilize here.  
 
Range Tab: Select the frame range for the stabilization. 
 

  
 
Fixed Frames:   Here you can enter the frames you want to be unaffected by 
stabilization.  Mocha will adjust the stabilization between these frames.  
You can either enter them into the field, or go to a frame and press the + key.  
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Fixed frames can be useful when you want stabilization across a shot but would 
like to keep the general motion of the original shot intact. 
 
Smooth:   This is the main section for controlling how you want the shot to 
stabilize. 
 

 
 
All Motion:   This checkbox sets all the options below it. 
 
X Translation:  Stabilize translation in X 
 
Y Translation:  Stabilize translation in Y 
 
Rotation:  Stabilize rotation 
 
Zoom:  Stabilize the scale/zoom 
 
X Shear:  Distort the footage according to the tracked surface’s shear data in X 
 
Y Shear:  Distort the footage according to the tracked surface’s shear data in Y 
 
X Perspective:  Distort the footage according to the tracked surface’s 
perspective data in X 
 
Y Perspective:  Distort the footage according to the tracked surface’s 
perspective data in Y 
 
Shear and Perspective stabilization can be useful when you want to straighten 
out a plane in your footage to work on it flat before restoring it to its original 
perspective and motion.  
 
Maximum Smoothing:  Stabilize across the entire track.  Setting this value will 
override the #Frames value beneath it.   
 
# Frames:  Stabilize variation across a certain amount of frames.  Setting this to 
a low value will focus the stabilization to only pick up motion that occurs in 
short bursts (such as a bump in the road).  A higher value will try to adjust 
longer movements. 
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Exporting Stabilized Tracking Data 
 

 
 
Exporting Stabilization is similar to exporting tracking.  When you hit the Export 
Stabilized Tracking Data button you will be presented with a dropdown box 
with options for various applications. 
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Rotoscoping Basics 
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For the following example you need the BMW tutorial 
files available from 

http://www.imagineersystems.com/downloads/clips/mot
or_quickstart.zip  

You can also watch a video tutorial covering some of 
the topics discussed at: 

http://www.imagineersystems.com/products/monet/000_
motor_quickstart_z.mp4 

Overview 
As you have seen, the Planar Tracker is a great 2D tracker. Now let's look at how 
we use the tracking data to roto a shot. 
 
The workflow will feel familiar to most artists, but there are a few fundamental 
differences. 
 
Rather than starting out with an accurate shape, we start out with a loose 
tracking shape, then we track that shape. We then add the accurate rotoshape 
and link this shape to the tracking data of the loose tracking shape. 

Adding Your Tracking Spline 
Create a new project using the BMW tutorial footage using default import 
options. 
 

Move to frame 1 and draw a very loose 
spline around the bulk of the front of the 
BMW.  
 
 
 
 
 
 
 

 
When you are done, select all the points on the 
spline using Ctrl/Cmd+A, then adjust the 
weights for all the control points 
simultaneously in order to round the shape. 
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Now double click the 'Layer 1' entry in the 
Layer Controls panel and rename the layer 
'BMW front track'. 
 
 
 

Similar to traditional rotoscoping approaches, we subdivide objects that are 
three dimensional or non-rigid into multiple layers. In this case we add a new 
layer to select and track the side of the BMW. Let's name this layer 'BMW track 
side'. 
 

 
 

Choosing Tracking Parameters 
Next we choose our tracking parameters, specifically making sure we are 
tracking the right type of motion, for example we need to select Perspective for 

the side of the car as there is a reasonable 
amount of perspective change on this 
plane. 
 
Select Perspective motion model for the 
'BMW side track' layer. 
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Select the Shear motion model for the 
'BMW front track' layer. 
 
Note: The Track | Motion parameters work 
in a hierarchical order i.e. selecting 
Rotation + Scale forces Translation to be 
selected and subsequently selecting 
Perspective forces all Motion parameters 
to be selected. Additionally it’s worth 
mentioning that the Motion parameters 
are keyframable as it can be useful to change the settings for part of the clip. 
Tracking 

 
Ensure that tracking is enabled for both 
layers, then click the Track Forwards button. 

 
 

 

Turning Layers On and Off 
Once tracking is complete and we have a satisfactory track, we deactivate the 
mattes of the tracking layers as we do not want them used in our renders. 
 

One method is to keyframe the Layer 
Active/Inactive state in the Curve Editor. 
The layer curve in the curve editor is a 
constant value of 0 or 1. 0 indicates that 
the layer is inactive and 1 indicates that 
it is active. Keep in mind that the Layer 
Properties allow you to turn off layer 
visibility in the canvas, but don’t affect 

the layer Active/Inactive state in any way.  
 
The second method is to set the In and Out 
range of that specific layer in the Layer Controls 
panel. The layer will become inactive 
automatically before and after the In and Out 
points (though you won’t see any keyframes 
created in the Curve Editor).  
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The final method is to right click on 
the layer in the Layer Controls panel 
or to right-click on the actual spline 
itself. 
 
If you right-click on the layer in the 
Layer Controls panel you can select to 
Deactivate or Activate the layer. 
 
 
 

 
 
 
 
Right-clicking on a spline 
brings up a contextual 
menu, giving you the ability 
to Deactivate the layer 
directly from the canvas. 
 
Once a layer has been made 
inactive, it will not be 
visible in the canvas. To 
make it active again, you 
must either right-click the 
Layer in the Layer Controls 
panel and activate it or 
change the active value in 
the Curve Editor. 
 
Keep in mind that if you have multiple splines on a single layer individual splines 
cannot be made active and inactive independently - only the layer on which they 
reside has this control. 
 

COMMON ERROR 

Deactivating the layers is not the same as merely hiding 
the layers using the 'eye' in the Layer Controls menu; it 
literally switches the layers off. This is a keyframable 
parameter so make sure the value is set for the entire 
project.  

 

Adding Your Roto Spline 
Once you have a track for a layer we recommend that you add a new layer to 
use for the actual roto spline, rather than refining the spline you used for the 
actual track as you might need to do more tracking with it later. 
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NOTE: Autokey should be on such that we are creating a keyframe for the spline 
on the frame we add the spline on. This is relevant as we will be refining the 
spline on other frames and need to ensure it is locked off on the frame we start 
on. 

  
Select the X spline or Bezier spline tool and draw a tight spline around the 
object you are rotoscoping. Ctrl/Cmd+drag the Bezier tangents if you wish to 
break them. You will see that a new layer is automatically created. 
 

 
 
Tip: You don’t want to inadvertently track with this layer, so disable tracking for 
the layer by turning off the tracking button (the cog) for the layer in the Layer 
Properties panel. 
 
You can also hide the spline use for tracking by turning off the display button 
(the eye) for that layer. 
 

Rename the new layer 'BMW side 
roto' and link it to the movement of 
your already tracked 'BMW side 
track' layer by selecting 'BMW side 
track' in the Link Splines to Track 

drop-down list. 
 
Your newly created roto spline will now follow the motion of the side of the car.  

Feather your edges 
Edges can be feathered either by dragging out feathers point by point using the 
edge pointer tools in the toolbar or by using the parameters in the Edge 
Properties panel.  
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In the toolbar you have four different pointer tools. The pointer tool with the 
'B' will move both the inner and outer spline point (‘B’ = ‘Both’). The 'I' pointer 
will only move the inner, and the 'E' pointer will only move the outer spline 
point (‘E’ = ‘Edge’). A feathered edge will occur between the inner and outer 
spline points. The 'A' pointer will remove either the inner or outer point 
depending on which is selected (‘A’ = ‘Any’). 
 
You can also use the Set button 
under Edge Properties to 
feather the edge at the selected 
point(s) an exact amount or use 
the Add button to 
increase/decrease the feather by 
the specified amount 
 
 
 
 

 
In this example, deselect all points 
by clicking anywhere on the canvas 
and use the Set button to apply the 
default 3 pixel edge width. Because 
no points are selected the value is 
applied to all points. Now tweak the 
position of all spline points to ensure 
that the inner (red) spline is inside 

the edge and the outer (blue) spline is outside the edge. 

Adding more rotosplines 
As many roto splines as required can be added using the steps above. Note that 
multiple roto splines of course can be linked to the same track if required. 
 
For the car, add a spline around the front of the 
car, name the new layer 'BMW front roto' and 
link it to the track of 'BMW front track'. 
Remember that Autokey should be active when 
you first add the frame to ensure that we 
automatically get a keyframe on that frame.  
This spline needs to be very accurate as it is the 
final roto spline for the front of the vehicle. 
Once added, feather the edges. 
 

Ensure that the front and side splines overlap 
100% such that the join will not be noticeable 
in the rendered matte. 
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For the side mirrors, you may want to create a single new layer that has two 
splines, one for each layer. 
 
To achieve this, add a new spline as 
usual for the left mirror. Feather the 
edge and position the spline 
accurately.  
 
 
 
 
 
 

 
Now select the spline tool with the '+' sign next to the B (or X if you are using X 
splines) and draw a spline around the mirror on the right. 
 
 
You will notice that both splines 
appear selected (red) at the same time 
because they belong to the same 
layer. Now rename the layer 'BMW 
mirrors'. Don't forget to link the layer 
to the track of the 'BMW front track' 
layer. 

 

Creating Keyframes 
After having added your roto spline(s), cycle through your clip and identify any 
areas that need manual refinement. You may turn Autokey on and adjust points 
at will - keyframes will then automatically be added whenever you adjust a 
point. 

 
You may want to add keyframes only to those 
points which you move. This is accomplished by 
switching the Keyframe By radio button to Points 
instead of Spline. When this switch is on Spline, 
moving any point will create a keyframe for 
every point in the spline. 
 
 
 
 
 

Green keyframe markers will be added to the timeline to indicate the presence 
of a keyframe on that frame. Only keyframes of the selected point will be 
shown. 
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Try to switch on Autokey mode and go to the last frame of the shot. Refine both 
the front and side roto splines by moving any points that have drifted away back 
into position.  
 
Now go to a frame in the middle of the shot, say frame 12. Again, reposition 
points as needed. 
 
Note: The idea is to refine the spline on as few keyframes as possible and instead 
depend on the tracking to drive the interpolation of the point positions 
between keyframes. The approach we describe here is 'divide and conquer', 
where you continually insert keyframes halfway between two existing 
keyframes until the spline is accurate enough between two keyframes for any 
further refinement not to be necessary. Another approach is to start at the first 
frame and skip, say 10 frames, forwards for each keyframe. 

What’s the Überkey? Powerful. And Dangerous. 
The Überkey is a powerful tool that allows you to offset the positions of control 
points without destroying their keyframe data. 

 
Use this tool with care, as it is not setting any keyframes per se, it is offsetting 
any and all keyframe data on the points you move while it is on. Überkey will 
save your life one day, but don't let it ruin your day. Use with care.  
 
Überkey affects only those frames between the timeline's In and Out point. If 
you wish to make adjustments to a particular range, set the In and Out points to 
that range. 
 
 
 

Translate, Rotate and Scale your Splines 
You can translate, rotate and scale selected points as a 
group by using the corresponding tools listed in the toolbar.  
 

 
 
 
 
 
An overlay shows the delta change. 
The center or anchor point of these 
movements appears where you first 
click your mouse. Keep in mind that 
these three tools do not work in 
conjunction with the Überkey 
function. 
 



 Quick Start | Reference 

51  
 

 
 
 
 
 
 

Turning On and Off Points 
You can turn on and off individual points in a spline. 
When they are off, you can still see the points, they 
can still be animated, but they are not contributing 
mathematically to the spline.  This allows you to have 
a complex spline only when you need it, rather than 
having to deal with superfluous points in parts of the 
shot when they are not needed. 
 

 
To turn off points, select the points 
on the spline and hit Shift+Delete. 
You will see the curve change 
shapes, but the points will remain.  
 
To turn a point back on, right-click 
on it and select Point->Activate.  
 
If the Autokey button is enabled, a 
keyframe will be created when you 
change a point’s active status. 

Add Motion Blur 
 
You can use the movement of the 
individual spline points to determine 
motion blur. Any movement in the spline, 
whether through simple X/Y translation or 
by shape deformation will cause motion 
blur.  
 
You can control the amount of blur by 
changing the motion blur value in the Edge 

Properties panel. 

Changing the Matte Blend Mode 
Although not necessary in this example, note 
that you can change how mattes are blended 
in the Layer Properties panel. You may make 
each layer’s matte Add or Subtract and you 
can also invert the matte.  
 
Note that this can't be keyframed and that 
these settings apply to the entire layer, not to 
individual splines of the same layer. 



 Quick Start | Reference 

52  
 

Viewing your Mattes 
In the View Controls, several options are offered for viewing your mattes. The 
Matte drop down is has options to view all mattes, just the mattes you have 
selected or no mattes. 

 
 
Select the Matte button and you will see your rotoscoped object against a flat 
background. 
 
 

 
 
 

Changing the Background Color 
You may wish to rotoscope against a 
particular color. Select View -> Canvas 
Color… and a color picker will allow 
you to choose a particular background 
color.  
 

 

 

 

 

Colorize your Matte Overlay 
When you have your Mattes turned on, you may 
choose for the matte to be filled with a color instead 
of cutting out the object, using Colorize.   
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You can adjust the opacity of the color fill by changing the blend 
value to the right of the Colorize button.  

 
 
The color used by Colorize is derived 
from the Selected and Unselected 
properties of the Overlay Colors 
panel, which can be changed per 
layer. 
 
This is only a preview and will not 
affect how your mattes are rendered 

when exporting. 
 

Preview Rendered Mattes 
 
In the View Controls panel, you will find a drop-down menu for selecting the 
clip to view.  

 
This allows you to view the actual rendered mattes, which can be especially 
useful when tweaking motion blur. The motion blur you normally see in your 
canvas is an OpenGL preview and can differ slightly from the actual render. 
 
If you’d like to see what the actual motion blur render looks like, switch to 

viewing the layer whose matte you 
wish to see. 
 
Because you can choose specific 
layers for export when you render, 
a render pass is created for each 
layer.  
 
Switch the View Clip drop-down 
back to your source clip to continue 
working with that clip.  
 

 
 
To actually render your matte for use in a composite, read the instructions in the 
chapter on exporting mattes. 
 



 Quick Start | Reference 

54  
 

 

 

 

 

 

 

 

Exporting Tracks 
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Exporting Tracks to Adobe After Effects 

It is important that the clip length, frame rate, frame 
size, interlace mode, pulldown mode and pixel aspect 
ratio in the project match the corresponding settings in 
the After Effects project where you plan to use the 
data. You can change the frame rate and pixel aspect 
ratio settings in the Film and Time sections of the Clip 
tab. 

This example illustrates how to export tracking data in a format readable by 
Adobe After Effects, how to import and create a corner pin using this data in 
After Effects, and how to stabilize a shot using the same data. 
 
It is important that the clip length, frame rate, frame size, interlace mode, 
pulldown mode and pixel aspect ratio in the project match the corresponding 
settings in the After Effects project where you plan to use the data. You can 
change these settings in the Film and Time sections of the Clip tab. 
 
Track an object in the usual way, and use AdjustTrack to correct for any drift if 
necessary. The exported tracking points will be the four corner points, so you 
should position these appropriately.  
 
Press the Export Tracking Data button on either the Track or AdjustTrack tabs. 
Next, choose either the After Effects Corner Pin Data or the After Effects 
Transform Data.  
 

 
 
After Effects Corner Pin Data: 
The corner pin data records and exports the 4 point x, y information from either 
the adjusted track or the raw track. There are three exports – two for recent 
After Effects versions and one for CS3 and older versions of After Effects. 
 
After Effects Transform Data: 
The transform data exports x and x positions as well as the scale and rotation for 
the whole surface. 
 
Now click Save. This will display a file browser; you need to select a filename and 
directory for the files to be saved. By default, the files will take the name of the 
layer, so for a layer name Track_Layer this export produced a file named: 
 
Track_Layer.txt 
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Taking this approach means you have a backup of your tracking data saved to 
disk. However, you can skip this step by pressing Copy to Clipboard, and going 
straight to pasting the data into After Effects. 
 
Now open After Effects and load the footage you tracked and the footage you 
wish to apply the tracking (corner pin data) to. Thus, your timeline will look 
something like this: 
 

 
 

 
Next open the text file you saved 
with the corner pin data, select the 
entire body of text and copy it. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Switch back to your After Effects window and locate and select the item on the 
time line that is the insert object. Paste the data to the selected layer. You can 
do this by selecting the ‘paste’ option in the edit menu or by typing “command-
v” (Mac) or “ctrl-v” (Windows). 
 

 
 

 



 Quick Start | Reference 

57  
 

With the layer’s information expanded you can see the 4-point tracking data 
now applied to the insert layer. 
 
 
 
The result is the image scaled 
and inserted correctly. 

 
 

 

 

 

 

 

Using Tracks For Stabilizing In After Effects 
 
You can use the tracking data created to stabilize a shot in After Effects. The 
process is simple.  

 
Track your footage as normal, then turn 
on the Surface button and center the 
surface box on the area you wish to use 
as the stabilize center. 
 
 
 
 
 

 
Export the tracking data in the After Effects Transform format. Switch to After 
Effects, select the layer you wish to apply the stabilize data to and paste it to 
that layer. 
 
Now delete the Position key frames. You can skip this step if you first delete this 
information from the saved text file before copying it to After Effects. 
 

 
Notice that only Anchor, Scale and Rotation have keyframes. 

 
Select the Rotation channel and click Animation | Add Expression. In the 
expression box enter the formula rotation*-1. 
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Scale and Rotation expressions 

 
Select the scale channel and click Animation | Add Expression. In the expression 
box enter the formula: 
 
x = 10000/scale[0]; 
y = 10000/scale[1]; 
[ x, y ]; 
 
You should now have a stabilized image. 
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Exporting Tracks to Final Cut Pro or Final Cut Express 
This example illustrates how to export Basic Motion data to Final Cut Pro or Final 
Cut Express, and use it to matchmove one clip to another, with translation, 
rotation and scale. 
 
Track an object in the usual way, and use AdjustTrack to correct for any drift if 
necessary. The exported tracking points will be the four corner points of the 
Surface, so you should position these appropriately before export.  
 
Press the Export Tracking Data button on either the Track or AdjustTrack tabs. 
Next, choose either the Final Cut Basic Motion or the Final Cut Distort options.  

 
Final Cut Distort: 
The distort option exports the 4 point x, y information from either the adjusted 
track or the raw track. The points exported are the four corners of the surface. 
 
Final Cut Basic Motion: 
The basic motion option exports x and y positions as well as the scale and 
rotation for the whole surface. The position exported is the centre of the 
surface. 
 
Now click Save. This will display a file browser; you need to select a filename and 
directory for the files to be saved. By default, the files will take the name of the 
layer, so for a layer name Track_Layer this export produced a file named: 
 
Track_Layer.xml 
 
Now open the Final Cut project where you want to use the tracking data. To 
import the XML file in Final Cut Pro, click File | Import | XML…. In Final Cut 
Express, click File | Import | FCP XML from iMovie… 
 
You will now see a new clip in your bin, 
named “mocha distort – layer_name” or 
“mocha basic motion – layer_name”. If your 
original footage was a QuickTime file, then 
the new clip in Final Cut will point to this 
footage. If it was an image sequence, the clip 
will be connected to the first frame of the 
sequence, stretched to the duration of the 
whole clip. 
 
In most situations, you want to apply the 
tracking data to a different clip in your 
timeline. To do this, you can copy and paste 
the data from the imported clip onto any 
other. 
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Drop your imported clip into the timeline, then select it and press Cmd-C to copy 
it to the clipboard. Now select the clip you want to apply the tracking data to 
and press Opt-V (Paste Attributes). You will see a dialog asking you to choose 
which data to paste. 
 
Depending on the kind of data you exported, tick either “Basic Motion” or 
“Distort” and untick all the other boxes. 
 
You should now see the clip following you  
tracked. 

Using Tracks for Stabilizing in Final Cut 

To use our tracking data for stabilization in Final Cut, follow the same procedure 
as for a basic motion export, but tick the Invert checkbox in the export dialog. 
 
Now when you import the XML file into Final Cut, you should have a fully 
stabilized clip. You can also copy the stabilized data onto another clip using 
Copy and Paste Attributes as before. 

Troubleshooting Tracking Export to Final Cut 
Many issues of track misalignment can be corrected by choosing the right film 
type, frame rate and interlacing settings in our software. These controls are on 
the Clip page in the Film, Interlaced and Time tabs. 

The layer doesn’t line up in Final Cut 
If the layer doesn’t line up but the overall motion looks right, the most likely 
problem is mismatched pixel aspect ratio (PAR). In Final Cut, check the sequence 
settings to confirm the correct PAR for the clip, then use the equivalent setting 
when tracking in our software. If you have already tracked with the wrong film 
type setting, you will need to re-track after changing it. The table on the next 
page shows the corresponding settings between Final Cut and Imagineer 
products. 
 
Frame Size Final Cut 

Aspect Ratio 
Final Cut Pixel 
Aspect Ratio 

Final Cut 
Anamorphic 

Imagineer 
Film Type 

320x240 Multimedia 
Large 

Square No HD 

640x480 NTSC (4:3) Square No HD 
720x480 NTSC DV (3:2) NTSC No CS4 DV NTSC 
720x480 NTSC DV (3:2) NTSC Yes CS4 DV NTSC 

Anamorphic 
720x486 CCIR 601 NTSC 

(40:27) 
NTSC No CS4 D1 NTSC 

720x486 CCIR 601 NTSC NTSC Yes CS4 D1 NTSC 
Anamorphic 

720x540 CCIR 601 NTSC 
Sq. (4:3) 

Square No HD 

720x540 CCIR 601 NTSC 
Sq. (4:3) 

Square Yes Custom, Pixel 
Aspect 1.333 

720x576 CCIR 601 / DV 
PAL (5:4) 

PAL No CS4 PAL 
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720x576 CCIR 601 / DV 
PAL (5:4) 

PAL Yes CS4 PAL 
Anamorphic 

720x576 CCIR 601 PAL 
Sq. (4:3) 

Square No HD 

720x576 CCIR 601 PAL 
Sq. (4:3) 

Square Yes Custom, Pixel 
Aspect 1.333 

1280x720 HDTV 720p 
(16:9) 

Square No HD 

1920x1080 HDTV 1080i 
(16:9) 

Square No HD 

960x720 HD (960x720) 
(16:9) 

HD (960x720) No DVCPRO HD 
720 

1280x1080 HD (1280x1080) 
(16:9) 

HD (1280x1080) No DVCPRO HD 
1080 

1440x1080 HD (1440x1080) 
(16:9) 

HD (1440x1080) No HDV 

 
Although film types are included in our software for anamorphic HD sizes 
(DVCPRO HD and HDV), you are unlikely to need to use them as QuickTime will 
normally apply the anamorphic scaling and our software will treat the video as 
full HD. 

The layer lines up on the first frame, but then it drifts 

This is usually caused by a frame rate mismatch. Check that the frame rate and 
interlacing settings match between final Cut and our software. 

The layer appears much wider or thinner than it should 

This can be caused by a mismatch in the Final Cut Anamorphic setting. If you are 
working with anamorphic footage, ensure that you have the “Anamorphic” 
setting checked in your Final Cut sequence settings, and in the clip properties. 
You also need to use one of the anamorphic film types when tracking: any of 
the film types with “Anamorphic” in the name should give correct results when 
importing the data into Final Cut. 
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Exporting Tracks to Apple Shake 
This section explains how to export tracking data in a format readable by Apple 
Shake, how to import the data into Shake and how to use it for match move, 
corner pinning and stabilization tasks. 
 
Track an object in the usual way, and use AdjustTrack to correct for any drift if 
necessary. The exported tracking points will be the four corner points of the 
Surface, so you should position these appropriately.  
 
Press the Export Tracking Data button on either the Track or AdjustTrack tabs. 
Next, choose 'Shake Script (*.shk) and click 'Save' to save the script to disk or 
'Copy to Clipboard' to simply copy-and-paste the data into Shake. 
 
 

 
 
 

Now let's use that data in Shake. To load the tracking 
data in a file into an existing Shake Script follow these 
steps: 
 
In the File menu, select ‘Add script’. 
 
Navigate to the Shake script file you exported and select 
it. 
 
If you have the data on your clipboard, simply press 
Ctrl/Cmd+V or right-click and choose 'Paste'. 
 
Three nodes will now appear in your script: Stabilizer, 
MatchMoveLayer, and CornerPinLayer.  
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At this point you have successfully imported your tracking data from mocha 
into Shake. But what exactly did you import? Let’s start with the 
MatchMoveLayer layer.  
 
The MatchMoveLayer 
is used to apply the 
tracking data to a 
foreground element 
that you wish to 
matchmove to a 
background. It consists 
of two inputs, the 
background and the 
foreground. The 
foreground element 
will be the element you wish to apply the match moving data to. The 

foreground is 
connected to the left 
side input of the node 
while the original 
tracked background 
element goes into the 
right hand side.  
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The next node is the 
CornerPinLayer node. 
This node has a single 
input and works just 
like the left input of 
the MatchMoveNode. 
  
 
 
 
 

 
It takes your foreground 
element and applies the 
scaling, rotation, and 
translation data to it and 
prepares it for compositing 
into your next layer. 
 
 
 
 
 
 
 

 
The last exported 
node is the Stabilizer 
Node. Just as the 
name implies, it takes 
all of the exported 
tracking data and 
uses that data to 
stabilize your input 
clip.  
 
 

 
With this node, for example, you 
may apply this data to the 
background element you tracked 
to make for an easier composite. 
 
Now that you have successfully 
exported and imported your data 
into Shake you are ready to 
continue working on your 
project. 
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Exporting Tracks to Nuke 
This section explains how to export tracking data in a format readable by Nuke, 
how to import the data into Nuke and how to use it for match move, corner 
pinning and stabilization tasks. 

 
Track an object in the usual way, and use AdjustTrack to correct for any drift if 
necessary. The exported tracking points will be the four corner points of the 
Surface, so you should position these appropriately.  
 
Press the Export Tracking Data button on either the Track or AdjustTrack tabs. 
Next, choose Nuke Ascii (*.txt)' and click 'Save' to save the script to disk.  
 

In Nuke, append a tracker to the background clip, 
e.g. by selecting the node and pressing tab, then 
typing 'tracker' and finally selecting the 'Tracker' 
node in the list of nodes. 
 
 
 
 
 
 
 

 
In the tracker properties window, select the animation 
submenu button for Tracker 1, then choose File | Import 
Ascii... in the menu. 
 
 
 
 
 
 

On the import Ascii dialog, press the folder 
button next to the file name, browse to the 
file you exported, select it, click 'Open' and 
then click 'OK'.  
 
Repeat these steps for tracker 2, 3 and 4. 
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Exporting Corner Pin tracks to Nuke 
You can export a Corner Pin straight to the clipboard or to a .nk script by 
choosing Nuke Corner Pin (*.nk) from the Export Tracking Data dialog. 
If you choose Copy to Clipboard you can immediately switch over to Nuke, select 
the node you wish to apply the corner pin to and Paste the data.  Alternatively 
you can import your saved Nuke Script from the File menu. 
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Exporting Tracks to Digital Fusion 
This section explains how to export tracking data in a format readable by Fusion, 
how to import the data into Fusion and how to use it for match move, corner 
pinning and stabilization tasks. 
 
Track an object in the usual way, and use AdjustTrack to correct for any drift if 
necessary. The exported tracking points will be the four corner points of the 
Surface, so you should position these appropriately.  
 
Press the Export Tracking Data button on either the Track or AdjustTrack tabs. 
Next, choose 'Digital Fusion COMP Data (*.comp)' and click 'Save' to save the 
script to disk.  

 
In Fusion, open the .comp file, then drag 
the tracker node into the right view. 
 
 
 
 
 
 
 
 

 
Now import the clip that you want 
composited onto the background 
and tie the output of the clip to the 
input of the tracker node. 
 
 
 
 
 
 

 
In the settings of the tracker node, select the 'Operation' tab 
and select either 'Corner Positioning' or 'Match Move' to 
composite the insert clip on top of the background. Notice that 
you can switch 'Position', 'Rotation' and 'Scaling' on and off for 
different effects. 
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Exporting Tracks to Inferno, Flame, Flint, Smoke and Combustion 
This section explains how to export tracking data in a format readable by 
Autodesk Inferno, Flame, Flint, Smoke and Combustion. 
  
Track an object in the usual way, and use AdjustTrack to correct for any drift if 
necessary. The exported tracking points will be the four corner points of the 
Surface, so you should position these appropriately.  
 
Press the Export Tracking Data button on either the Track or AdjustTrack tabs. 
Select “Autodesk IFFFSE Point Tracker Data (*.ascii)” as the format, and save this 
to a file. Next select the “Autodesk IFFFSE Stabilizer Data (*.ascii)” export and 
save this to another file. 
 

 
 

Importing into Combustion 

Let's look at how we use the data. In Combustion, create a layer with the 
foreground graphic and set the layer shape to 'Four-Corner'. 

 
 



 Quick Start | Reference 

69  
 

Now select all four corners of your layer, enable the 'Tracker' tab and select 
'Import Tracking Data.' 
 
Import the single ascii file with the stabilizer tracking data. 
 
Activate the insert layer visibility and you will see that the insert layer is now 
tracked to the background element, even though the image is not sized 
correctly yet. Select all trackers and set the mode to 'Absolute' to resolve this. 
 
If you prefer to import your data one point at a time you can instead select one 
track point and import the ascii file with the corresponding tracking data. 
Remember to switch to 'Absolute' mode once all data has been imported. 

Importing into Inferno, Flame, Flint or Smoke for Corner Pinning 
Firstly, we will set-up a corner-pin composite in the 
Action module, to reproduce the basic compositing 
operation. 
 
Enter Action and delete the default Axis and 
Image nodes.  
 
Create a new Bilinear Surface.  
 
Tap on bilinear1 then press ~ to view its settings. 
 
Go to Surface then click the S button next to Track  

 
 

You should now be in the familiar stabilizer module. For this example we are 
doing a corner-pin so we will need to use all four trackers. 
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Tap Tracker 1 then press 'Imp' under 'Track Y'. 
 

 
 
Now browse to the corresponding file, e.g. xxxx_top_left.ascii. The files 
correspond to trackers as shown below. 
 
You should see the marker for Tracker 1 move into the correct position. 
 

 
 
Repeat the process for the other three trackers, making sure that you use the 
correct files as shown in above. You should also mark each tracker as Active if it 
is not already. 
 
Tap Return to return to Action, and you should now see your finished corner 
pin. 

top_left 

bottom_left 

top_right 

bottom_right 

Tracker 1   Tracker 2 

Tracker 3 Tracker 4 
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Importing into Inferno, Flame, Flint or Smoke for Stabilization 

An alternative use for the tracking data is for stabilization. You can use the 
Stabilizer module to do 1-, 2-, 3- or 4-point stabilization. In this example, we will 
do a 1-point stabilization to stabilize for position only, using the centre point. 
 
Enter the Stabilizer module. 
 
Click the Imp button under Track Y, as for the Corner Pin. 
 
Select the _center file, in my example this is PDA_center.ascii. 
You should now see the key-frames loaded and be able to process 
 
If you want to use more points to stabilize zoom, rotation, affine and 
perspective moves, just load the corner tracks as described in the Corner Pin 
section.  
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Exporting Tracks to Avid DS 

It is important that the clip length, frame rate, frame 
size, interlace mode, pulldown mode and pixel aspect 
ratio in the project match the corresponding settings in 
Avid DS  project where you plan to use the data. You 
can change the frame rate and pixel aspect ratio 
settings in the Film and Time sections of the Clip tab. 

This section explains how to export tracking data in a format readable by Avid 
DS. 
  
Track an object in the usual way, and use AdjustTrack to correct for any drift if 
necessary. The exported tracking points will be the four corner points of the 
Surface, so you should position these appropriately.  
 
Press the Export Tracking Data button on either the Track or AdjustTrack tabs. 
Select “Avid DS Tracking Data (*.fraw)” as the format, and save this to a file. 
This stores the x/y coordinates of the four surface points defining the track in 
eight .fraw text files using the following naming convention: 
 

…._R1x.fraw Lower left X coordinate 
…._R1y.fraw Lower left Y coordinate 
 
…._R2x.fraw Lower right X coordinate 
…._R2y.fraw Lower right Y coordinate 
 
…._R3x.fraw Upper left X coordinate 
…._R3y.fraw Upper left Y coordinate 
 
…._R4x.fraw Upper right X coordinate 
…._R4y.fraw Upper right Y coordinate 

 
Where “….” is replaced by the name of the exported layer. 
 
On your DS v10.x system, create a Tracker node and open the Animation Editor 
for it. In the left window check the little Blue Animation box to the left of R1x, 
R1y, R2x, R2y, R3x, R3y, R4x, and R4y. Now right-click "R1 Tracker Y" and select 
"Import tracking coordinates". Navigate to the folder containing the eight 
FRAW files that Mocha created and DS will load them. If you have an older 
version of DS then you will have to load each of the eight FRAW files 
individually. 
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Exporting Tracks to Quantel generationQ systems 

To import data into the Quantel requires Imagineer's 
TrackImport plug-in for Quantel. 

You can import tracking data into Quantel systems by using Imagineer's 
TrackImport plug-in. 
 
Track an object in the usual way, and use AdjustTrack to correct for any drift if 
necessary. The exported tracking points will be the four corner points of the 
Surface, so you should position these appropriately.  
 
Press the Export Tracking Data button on either the Track or AdjustTrack tabs. 
Select “Quantel Corner Pin Data (*.xml)” as  the format, and save this to a file.  
 
In the Quantel system, select the TrackImport plug-in, and use the plug-ins file 
browser interface to select the tracking data file to import. Then click 'Settings' 
and choose 'Tracker' in the settings window and click 'Save'. 
 
The tracking data can now be used in a manner identical to tracking data 
generated within the Quantel system. 
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Exporting Tracks as raw XML 
 
You can export the tracking data as XML Motion Matrix Data for simple parsing 
with any standard XML parser. The XML files contain the motion homographies 
computed by the tracker in each frame. These are 3x3 matrices representing the 
2D image motion measured in each frame relative to the first. Given a point 

00 , yx  in the first image, the corresponding tracked coordinates jj yx ,
in frame 

j  are given by 
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with the jXX
, jXY

, … representing the entries in the homography matrix in 

frame j , corresponding to the entries written into the XML file. The origin of 
yx,  coordinates is the top left corner of the image. λ  is a scale factor, different 

for each point/frame, which can be computed and eliminated using the bottom 
row of the above equation. 



 Quick Start | Reference 

75  
 

 

 

 

 

 

 

 

Exporting Mattes 
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Exporting Rendered Mattes 
 
Note: This feature is only available in some applications. 

 
When your roto work is complete and you’d like 
to export your mattes, choose the menu item 
File -> Render… to be guided through the 
rendering process. 
 
The Render Clip Wizard offers various settings 
to help you export the render that you need. 
Because your mattes are always being rendered 
internally, they will show up as an option in the 
drop-down menu. The first thing you’ll want to 
do is to set the Clip to Export. If you wanted to 
export a single matte you could choose it as the 
Clip to Export and then simply click Next. 
 

However, most often you will want to export multiple mattes rendered into a 
single clip and maybe even render it into the alpha channel with the 
background plate in the RGB channels. This can be achieved by leaving the Clip 
to Export set to the background clip, then selecting Matte under Channels and 
finally selecting the 
layers you wish to 
include in the render. 
 
If you deselect RGB you 
get a single channel 
grey level clip rendered, 
if the format you choose 
to export in supports it. 
If you select RGB, the 
background clip will be 
exported in the RGB 
channels. Selecting 
Alpha, which will only 
be available if the 
background clip had an 
alpha channel, will add 
the alpha channel to the 
mattes. 
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Some applications do not support all the export 
formats described below. Importing mocha shape data 
into other applications requires the mocha shape plug-
in for that application. 

Exporting as G-Masks and Shake Rotosplines 
Choose a shape (not a layer) and select Export 
Shape Data… from the File menu. A 
dialog will show with a drop-down containing 
3 different saving options. 
 
Choose the target application and hit Save. 
The data going into the file is not binary, and 
is shown in the dialog so that you may copy 
and paste it directly into a text editor if you 
prefer to work that way.  
 
Because of differences in the way Splines are 
handled in the applications (Combustion and 
Flame handle splines differently), maintaining 
accurate keyframe interpolation between our 

software and the other applications requires that the exported shapes have a 
keyframe on every frame. This is not a bug but required to ensure your mattes 
look right once they’ve been imported into your compositing application. 
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Exporting as mocha shape for After Effects Data 

It is important that the clip length, frame rate, frame 
size, interlace mode, pulldown mode and pixel aspect 
ratio in the project match the corresponding settings in 
the After Effects project where you plan to use the 
data. You can change the frame rate and pixel aspect 
ratio settings in the Film and Time sections of the Clip 
tab. 

 
The mocha shape plug-in will import the following data into After Effects: 
 
� One or more shapes, which may be either Bezier or X-Spline  
� The 'plane' that was generated by the Planar Tracker. This defines the 

overall movement of the shape(s) 
� Shape point keyframes set in the project 
� Per-point feathered edges 

 
If you wish to export a single layer, select it before proceeding with the export. 
 
When you are ready to export, select Export Shape Data button. On the dialog 
that opens, choose if to export the selected layer, all visible layers or all layers. 
 

 
 
When you have made the right selection, click Copy to Clipboard, then switch to 
After Effects. 
 
In After Effects, import the same footage and ensure that the frame rate and 
pixel aspect ratio are the same as those used when generating the shape. You 
can change these values in After Effects by selecting File | Interpret Footage | 
Main.... 
 
Bring the footage into a composition, then select Edit | Paste to add the shape 
effects to the composition. Each shape exported will come across as its own 
plug-in effect. 
 
In the plug-in controls you can change the following parameters: 

Blend mode 

You can choose to change the blend mode from the one assigned to the shape 
by selecting Multiply, Add or Subtract from the dropdown menu. 
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Invert 

When checked, inverts the matte. 

Render soft edge 

If you have created the shape with feathered edges but wish to switch these off, 
untick this parameter. Note that if you have not created feathered edges this 
will have no effect. 

Render type 

This setting allows you to choose between various render effects. The default is 
the 'Shape cutout' which uses the matte to cut out the corresponding area in the 
background footage. 'Color composite' will apply a single color to the area 
within the matte, useful when wanting to preview the positions of multiple 
layers. Note that the Opacity setting affects this color fill, allowing you to blend 
it with the background footage. 'Color shape cutout' combines the effects of the 
previous two. 

Shape color 

Defines the color of the color fill applied when selecting the 'Color composite' 
render type. 

Opacity 
Defines the opacity of the color fill applied when selecting the 'Color composite' 
render type. 
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Exporting as mocha shape for Final Cut 
The mocha shape plug-in will import the following data into Final Cut: 
 
� One or more shapes, which may be either Bezier or X-Spline  
� The 'plane' that was generated by the Planar Tracker. This defines the 

overall movement of the shape(s) 
� Shape point keyframes set in the project 
� Per-point feathered edges 

 
If you wish to export a single layer, select it before proceeding with the export. 
 
When you are ready to export, select Export Shape Data button. On the dialog 
that opens, choose if to export the selected layer, all visible layers or all layers. 
 
When you have made the right selection, click Save and select a destination to 
save the XML file to, then switch to Final Cut. 
 

In Final Cut, import the XML file by 
CTRL-clicking in the project asset 
window. 
 
Select 'Import', then 'XML...' and 
finally select the XML file that you 
exported. 
 
Accept all the defaults in the 'Import 
XML...' dialog. 
 

 
Your mocha shape 
sequence will now 
appear in your list of 
project assets. 
 
 
 
 

 
To use the shape to composite the rotoscoped object over a new 
background, simply place the mocha shape sequence in a video 
track above the background sequence. 
 
 
 
 

Additional controls 

If you want access to the actual matte, 
individual layers of the matte or control that 
affect the appearance of the matte, double 
click on the mocha shape sequence to reveal 
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the two main sequences it consists of - the original sequence and the 
ContourSequence. 

 
Double clicking the ContourSequence will reveal the 
individual layers that the ContourSequence consists 
of. Dragging a layer into the viewer and selecting 
'Controls' will give you access to controls of that 
layer, as shown below. 
 

 

 

Invert 

When checked, inverts the matte. 

Soft edge 
If you have created the shape with feathered edges but wish to switch these off, 
untick this parameter. Note that if you have not created feathered edges this 
will have no effect. 

Render mode 
'Luma' will cause the layer to render itself in the RGB channels, whereas 'Alpha' 
will cause the layer to render itself in the alpha channel of the generated 
sequence. 

Matte color 

Defines the color of the matte being rendered. 
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Exporting RotoPaint nodes to Nuke 
You can export a RotoPaint node straight to the clipboard or to a .nk script by 
choosing Nuke Roto Paint (*.nk) from the Export Shape Data dialog. 
If you choose Copy to Clipboard you can immediately switch over to Nuke, select 
the node you wish to apply the shape data to and Paste the data.  Alternatively 
you can import your saved Nuke Script from the File menu. 
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The Curve Editor 
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Navigating the Curve Editor 
You may navigate the Curve Editor space by using the middle mouse button to 
Pan and the mouse wheel to zoom. Alternately, you may pan using the ‘x’ key 
on the keyboard and zoom using the ‘z’ key on the keyboard. When zooming 
with the ‘z’ key, left/right mouse movements will zoom in/out horizontally and 
up/down mouse movements will zoom vertically. 

Selecting and Moving Keys 
To select keyframes, you must first select the curve, then the keyframes. 
Keyframes of unselected curves are not selectable. 
 

 
 
 
You may move the keyframes manually by 
dragging them with the mouse, or you may 
type in a “Nudge” value at the top right of 
the Curve Editor. 
 
Entering a negative value in the “Nudge Time” field and hitting the button will 
move selected keyframes backwards in time by that amount every time you hit 
the button. Entering a positive value in the “Nudge Value” field and hitting its 
button will move selected keyframes up in value by that amount every time you 
hit the button. 

Changing the Interpolation of Keys 
Interpolation describes the method of how values are calculated between 
keyframes. It defaults to linear interpolations between keyframes but you may 

wish to convert them to Bezier for easing 
in and out. Or if you wish them to hold 
their position until the next keyframe, you 
may wish to select Constant as the mode 
of interpolation. 
 
Right click on a selected keyframe and 
choose Interpolation->Bezier. Bezier 
tangent controls will appear on your keys 
and you may adjust them for easing in and 
out. 
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Changing the Extrapolation of Keys 
If a keyframe is the first or last keyframe on the curve, its extrapolation can be 
chosen. Extrapolation describes the method of how values are calculated “off 
into space” before the first keyframe or after 
the last keyframe. It defaults to Constant, 
which simply holds the value steady. 
 
Choose linear extrapolation and the curve 
editor will continue the value on its current 
slope (sometimes called Gradient 
Extrapolation in other applications). 
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Clip Management  
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About Clips 
You can import any number of 
clips into the workspace. Much 
like a compositing application, 
you can have a multitude of 
assets in the application you may 
wish to work with at any given 
time. As clips are imported into 
the workspace, they populate Clip 
list drop-down menus found 
throughout the application. 
 
Above is shown a list of clips that 
have been loaded into a 
workspace.  
 
 

 

Importing Clips  
The first clip is always 
imported when you start a 
new project. Once you 
import the first clip, the 
base resolution for that 
particular project is 
established. 
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Additional clips can be imported into the 
workspace through the Clip tab. 
 
The clips must match the base clip resolution 
set for the project (the resolution of the first 
clip you imported when you started the 
project). 

 

 
 

Removing Clips from the Workspace 
You may clean up the workspace by deleting clips you no longer need. Select the 
clip in the clip drop-down list and hit Delete. That clip will be removed from the 
workspace. 

Relinking Clips in the Workspace 
You may wish to relink a clip in the workspace. Select the clip from the clip drop-
down list and hit Relink. You will be presented with a traditional file browser 
and asked to select the clip you wish the original to be replaced by. Make sure 
they have the same resolution as the project base clip. 

Selecting a Clip to Track 
Most often, the first clip you imported will be the one you wish to track. There 
are times when you may get an updated shot with color correction or some 
other enhancements to make tracking easier. To use this new clip, you must first 
import it into the workspace as described above. 
 
To select to track on this new clip, you must choose it in the Track tab's Input 
drop-down. 

Selecting a Clip to Rotoscope 
Rotoscoping can be done on any of the clips 
you have imported. To change the clip you 
are viewing in the canvas, select the clip in 
the View Controls drop-down list.  You will 
notice that any clip you’ve imported into the 
workspace will appear here. 
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Keyboard Shortcuts 
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About Keyboard Shortcuts 
Below you will find a list of commonly used keyboard shortcuts. Additional 
shortcuts can be found by browsing the menus and the list of modifiable 
keyboard shortcuts in preferences.  
 

Common Shortcuts  
  
CTRL/CMD + F Enable Picker tool 
I Toggle insert point mode on/off 
Z Enable Zoom tool while pressed 
X Enable Pan tool while pressed 
CTRL/CMD + L Enable X spline tool 
CTRL/CMD + B Enable Bezier spline tool 
CTRL/CMD + Click Break Bezier handle 
CTRL/CMD + Z Undo  
CTRL/CMD + SHIFT + Z Redo  
C Close contour 
D Delete point 
W Rotate 
Q Translate 
E Scale 
- Zoom out 
+  Zoom in 
/ Zoom to 100% 
* Zoom to fit 
SHIFT + Q Go to start of clip 
� Go to previous keyframe 
� Go to previous frame 
� Go to next frame 
� Go to next keyframe 
SHIFT + W Go to end of clip 
ESC Stop processing 
Space Start/stop playback 
SHIFT + I Set in point 
SHIFT + O Set out point 
K Add/delete keyframe 
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Preferences  
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Preferences are accessed through File | Preferences on Windows or Linux and 
Application Menu | Preferences on Mac. 

Output Settings 

File Storage 
The Output Directory settings specify the default location of the directory in 
which the project file and rendered clips are stored. There is a choice between: 
 
Relative Path: The project directory is a subdirectory of the directory containing 
the original project clip. By default, the subdirectory is Results. If you often load 
your project clip over a network, it would be best not to choose Relative Path, 
because the performance of project and clip I/O will not be as fast as the local 
disk. 
 
Absolute Path: The project directory as an absolute path. For the best 
performance choose a folder on a fast disk, with plenty of disk space available. 

Disk Space Available 
If Absolute Path is specified, the available space in the given disk drive. 

Cache Directory 

Specify here the folder to use for caching image data and storing auto-saved 
project files. For the best performance, choose a folder on a fast disk with plenty 
of disk space available. A lot of data is written out in the background while you 
work, approximately three times as much disk space as the taken up by the 
original clip will be used.  
 
The Cache Original Clip box is selected by default. This will cache the original 
clip to the File Cache when a project is created or opened for a more efficient 
playback and workflow. 

RAM Player 

The Use Textures box is selected by default. This will use textures when 
rendering, so set Amount of Texture RAM to Reserve to the amount of memory 
that you want to be reserved for textures. This determines how many frames can 
be played back in real-time. A reasonable setting would be ¾ of your graphics 
card’s memory. 
 
Using textures will usually result in faster rendering, but may not work on all 
graphics cards. Textured rendering is not compatible with Microsoft Windows 
Remote Desktop Connection. 

System 

Autosave 
The Enable box is selected by default. This will automatically save the project 
you are working on. Set the interval between saves by increasing or decreasing 
the value in the Interval (minutes) box. The default is 5 minutes. If Save Images 
Every Frame is checked, rendered frames are saved to disk as soon as they are 
created in memory; otherwise the render to disk only occurs when rendering a 
sequence of frames. 
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UI Color 

This decides the color of the user interface. You can choose if you prefer the user 
interface to be dark or light. If you choose to change from dark to light or vice 
versa, you will need to re-launch the application for the change to take place. 

UI Look and Feel 
This decides whether the user interface is displayed Full Screen or within a 
Window. If you are working with multiple applications, you may wish to set the 
UI Look to Window, as you cannot minimize the main window with Full Screen 
selected. 
 
By default, the application uses Rotational Controls to change parameter values. 
You drag with the mouse or pen away from, and then around, the parameter 
being changed. For those users who prefer traditional linear controls, switch to 
Linear Controls, which change the value of a parameter by dragging a handle 
underneath the parameter edit box. If Invert Mouse Wheel is checked, dragging 
the mouse wheel down will move up the timeline or reduce the value of a 
chosen parameter, and vice versa. 

History 

The Maximum Size of the history is the number of user interactions stored in the 
undo/redo command list. The limit is used to conserve memory. 

Default Clip Settings 
If you are working on a number of shots that share the same clip attributes (the 
same video standard, frame rate and colorspace), it can be useful to set a default 
clip setting. Then you will not have to re-enter the same clip information each 
time you load a clip. 

Format 

This is the default file format for rendered clips, when the format is not 
transferred from an input clip. This should be a format that supports all internal 
pixel formats and types. Currently the choice is between DPX and TIFF. 

Colorspace 

Select Linear if your source clip is stored in linear color space, possibly with 
gamma applied. Select Log if your source clip is stored in log color space. Select 
Panalog if your clips originate from a Panavision Genesis camera, and are stored 
in the native Panalog format. 

Convert to Float 

Convert to Float causes imported clips to be generated internally as 32-bit float, 
increasing the precision of compositing operations but using more memory. 

Time 
FPS - Choose a default clip speed in frames per second (FPS) from the pull-down 
menu. You can also select here whether to show Frames or Timecode for the 
frame numbers shown for the in/out points and current frame. Choose Timecode 
if you usually work with clips with DPX timecode or QuickTime clips containing 
timecodes. With the Frame Offset you can choose to apply a positive or negative 
offset value to each shot that you import should you wish to make the clip you 
are importing begin earlier or later by slipping the start point forwards or 
backwards. 
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Interlaced 

Select the Frames button when importing a clip that is frame-based. This will 
usually be a film clip, CG clip or a graphic. Select the Separate Fields button if 
you normally use field-based clips. This will usually consist of a video clip with 
options for PAL (upper field first, also used for SECAM) or NTSC (lower field first) 
field ordering. Separate Fields will de-interlace the clip and display both fields. 
When a clip is rendered, the fields will automatically be interlaced back together 
again. There is also a 3:2 Pulldown option if you mainly work with 3:2 pulldown 
material. 

Log 

Enable Error Logging 
This is selected by default. The file generated is useful for Imagineer engineers 
to diagnose error messages and fix any problems. You can view the log by 
selecting View Log from the Help menu. You can also change the location of the 
Log File from its default. 

Error Detection 
This is set to Comprehensive by default. If you are working on a labor-intensive 
project, you can switch to Normal only logs errors as they occur, rather than 
constantly checking. This provides less information in the event of an error, but 
can marginally improve performance. 

Help 
Here you find default settings for the: 
• Web Browser, used to access the online tools in the Help menu; 
• PDF file reader, used to open the manual. 

Key Shortcuts 
Select a module from the pull-down menu to reveal a list of keyboard shortcuts 
for that module. 
 


